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Система автоматизации 
проектирования  Quartus II
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План

■ Введение в проектирование в пакете Quartus® II
■ Схемный ввод описания проекта. 
■ Понятие «проект» в пакете Quartus® II
■ Компиляция проекта
■ «Single & Multi-Clock» временной анализ
■ Система  LogicLock™ 
■ Моделирование в пакете Quartus® II
■ Встроенный логический анализатор SignalTap II
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Введение в проектирование в пакете 
Quartus® II
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СБИС Программируемой Логики 
фирмы Altera

■ Семейства СБИС 
– High & Medium Density FPGAs

• Stratix, APEX II, APEX 20K, & 
FLEX 10K

– Low-Cost FPGAs
• Cyclone & ACEX 1K

– FPGAs With Clock Data Recovery
• Stratix GX
• Mercury

– CPLDs
• MAX 7000 & MAX 3000A

– Embedded Processor Solutions
• NiosTM, ExcaliburTM

– Configuration Devices
• EPC
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Системы автоматизации 
проектирования фирмы Altera

– Quartus II
• Stratix, Stratix GX, Cyclone, APEX II, APEX 
20K/E/C, Excalibur, & Mercury Devices

• FLEX 10KE, ACEX 1K, FLEX 6000, MAX 
3000A, MAX 7000AE, & MAX 7000B Devices

– Quartus II Web Edition
• Бесплатная версия  
• Система с ограниченными возможностями

– MAX+PLUS II
• FLEX, ACEX, & MAX 
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Методология проектирования СБИС ПЛ

Синтез
  - Преобразование описания проекта в схему, реализуемую на 
заданной элементной базе
  - Оптимизация схемы с учетом ограничений по 
быстродействию и занимаемой площади СБИС (Spectrum, 
Synplify, Quartus II)

Техническое 
задание

Разводка и размещение внутренних 
ресурсов СБИС с учетом наложенных 
ограничений на быстродействие и 
занимаемые логические ресурсы

Ввод описания проекта
    - Поведенческое и/или структурное 
описание проекта

Моделирование
  - Функциональное моделирование 
(Modelsim, Quartus II)
  

LE M512

M4K I/O
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Методология проектирования СБИС ПЛ

Временной анализ
  - проверка соответствия созданной СБИС 
требованиям к быстродействию
  

Моделирование на вентильном уровне
  - Временное моделирование
  - проверка правильности функционирования 
проекта после этапов синтеза, разводки и 
размещения
  

Тестирование и отладка 
СБИС в составе системы  
(ISP, SignalTap II )

tclk
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Возможности пакета Quartus II 

■ Различные способы ввода поведенческих и 
структурных описаний проекта

■ Интегрированные средства помощи  для создания 
сложных проектов MegaWizard® & SOPC 

■ Система синтеза
■ Система размещения внутренних ресурсов и разводки 

СБИС
■ Система моделирования
■ Система временного анализа и анализа 

потребляемой энергии
■ Система программирования СБИС
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Возможности пакета Quartus II

■ Средства оптимизации быстродействия 
проекта-LogicLock™ 

■ Система поддержки интеграции с другими средствами 
автоматизации проектирования-NativeLink® 

■ Система проектирования блоков цифровой обработки 
сигналов-DSP Builder

■ Интегрированные средства разработки ПО для 
встраиваемых микроЭВМ

■ Поддержка использования IP-модулей
■ Встроенные средства отладки СБИС в составе 

системы SignalTap® II & SignalProbe™ 
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Возможности пакета Quartus II

■ Поддержка операционных систем Windows, Solaris, 
HPUX, Linux

■ Поддержка различных схем лицензирования 
(node-locked, network)
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Менеджер пакета Quartus II
Меню менеджера 
пакета

Панель 
инструментов

Навигатор проекта

Окно состояния 
процедуры 
компиляции 
проекта

Окно процессора 
сообщений

Отчет о результатах компиляции 

Название проекта и его 
рабочая папка
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Настройка опций пакета Quartus II

Меню:Tools > Options...
Настройка лицензии:

- Выбрать категорию       
“License Setup”

-В окне “License file” указать 
местоположение 
лицензионного файла
- Раздел “Sistem info” указывает 
идентификационные 
параметры Вашего компьютера
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Способы ввода описания проекта

■ В рамках пакета Quartus II
– Текстовый ввод (AHDL, VHDL, Verilog)
– Редактор памяти (Hex, Mif)
– Схемный ввод

■ Возможность ввода проекта в других средствах 
автоматизации проектирования
– EDIF, HDL, VQM

■ Возможность использования Мегафункций и IP-
модулей

■ Возможность одновременного использования 
указанных выше способов в любом сочетании



Copyright © 2003. Тренинг партнер фирмы Altera®   в России.  Санкт-Петербург,  СПбГПУ - ЭФО14

Quartus II
Редактор 
памяти

Quartus II
Текстовый 
редактор

Quartus II
Схемный 
редактор

Top-Lev
el File

.bdf

.gdf

Файл верхнего уровня в 
иерархии описания проекта 
-  .bdf, .tdf, .vhd, .vhdl, .v, .vlg, 
.edif or .edf

.bsf .vhd

Block
File

Symbol
File

Text
File

Text
File

.v

Text
File

Импортируются из других 
средств автоматизации 
проектирования

Mentor Graphics,
Synopsys,
Synplicity,
etc...

Создаются в пакете Quartus II

VHDL

Символ 

Схема 
.tdf

Text
File

AHDL

Verilog

.edf
.edif

Text
File

.v, .vlg,
 .vhd, .vhdl, 

vqm

MegaWizard®

Файлы с описанием проекта
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Текстовый ввод описания проекта

■ Возможности
– Нумерация линий
– Использование заготовок языковых конструкций
– Отображение ключевых слов выбранными цветами
– Подсказка о необходимости сохранения файла  

■ Используемые языки описания аппаратуры 
– AHDL ( стандартное расширение - .tdf)
– VHDL (стандартное расширение - .vhd)
– Verilog (стандартное расширение - .v)
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Мастер MegaWizard

■ Мастер  MegaWizard облегчает процедуру настройки мегафункции и 
IP-модулей
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Базовые библиотеки пакета

– Мегафункции, созданные фирмой Altera модули, позволяющие 
использовать архитектурные особенности СБИС ПЛ

• ALTPLL, ALTLVDS, ALTDDIO...
– Библиотека стандартных параметризируемых модулей ( LPMs )

• Параметризируемые логические модули (lpm_and, 
lpm_decode...)

• Параметризированные арифметические модули 
(LPM_ADD_SUB, LPM_COUNTER…)

– Библиотека примитивов
• AND, OR, INPUT, DFFE

– Библиотека компонентов 74 серии
• 161mux, 8fadd, 7400 series logic

– Дополнительные библиотеки (User Libraries)
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Задание пользовательских библиотек

1. Из  меню Project выполните команду  
General Settings > User Libraries

2. В окне “Library name” укажите путь к 
библиотеке и нажмите кнопку “Add”

3. Нажмите кнопку OK
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Схемный ввод описания проекта в 
пакете Quartus® II
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Схемный ввод описания проекта

■ Схемный редактор интегрирован в пакет QuartusII
■ При создании схемы могут использоваться:

– Простейшие логические элементы, триггеры, выводы и другие 
примитивы

– Параметризируемые модули 
– Мегафункции, созданные фирмой  Altera модули
– Ранее созданные (в текстовом или графическом редакторах) 

компоненты 
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Ввод символов в схему

Используя иконку панели 
инструментов
(либо двойным щелчком в поле 
схемы)
откройте окно «Symbol»

Компоненты, расположенные 
в рабочей папке проекта

Библиотечные компоненты 
пакета

Графическое изображение 
(символ) выбранного компонента

Имя выбранного компонента
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Шины, цепи, каналы связи

Инструмент  для рисования каналов связи (Conduit)

Инструмент  для рисования шин (Bus)

Инструмент  для рисования цепей (wire)
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Изменение имени и свойств объекта

Выберите объект, 
щелкните правой 
клавишей манипулятора,
в появившемся окне 
выберите строку 
“Properties”

В окошке “Pin name(s)” задайте имя 
вывода. 
В окошке “Default value”  значение 
по умолчанию.
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Создание символа

Выполните команду 
Меню File>Create/Update>Create Symbol for Current File

Символ создается в рабочей 
папке проекта

Откройте схемный или текстовый редактор с описанием 
компонента для которого будет создаваться символ
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■ Меню : Tools > Options

Задание опций схемного редактора
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Редактор файла инициализации 
памяти.
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Редактор памяти

■ Создание (редактирование) файла инициализации 
памяти в формате  (.hex) или  (.mif)

■ Использование для создания СБИС 
– Если в проекте есть блок памяти ( RAM, ROM,  Dual-port 

RAM), то редактор памяти позволяет задать содержимое 
памяти, которое будет загружено при включении питания 
СБИС

■ Использование  для моделирования
– Редактор памяти позволяет задать содержимое модуля 

памяти для проведения моделирования
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Меню : File > New > закладка Other Files

Hex формат
Mif формат

Редактор памяти – создание нового файла
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Редактор памяти – создание нового файла

■ Укажите число слов (Number of Words) 
в модуле памяти и их размер (Word 
Size).

Слова (ячейки)
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Использование файла инициализации памяти 

Укажите  MIF or HEX 
файл 
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Понятие «проект» в пакете 
Quartus II
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Проект в пакете Quartus II

■ Под термином «проект» понимается набор файлов, связанных с 
проектируемым модулем, и библиотек.
– Файлы могут быть:

• Логическими – описывающими алгоритм работы модуля. 
• Вспомогательными – содержащими дополнительную информацию 

о проектируемом модуле
– Проект может содержать либо несколько логических файлов, 

образующих иерархическое описание модуля (при этом один из 
логических файлов должен быть файлом верхнего уровня иерархии 
описаний), либо один логический файл (по умолчанию являющийся 
файлом верхнего уровня в иерархии описаний).

■ Проект может быть создан с помощью:
– Мастера New Project Wizard
– Управляющий программ на языке tcl (test control language), 

созданных либо пользователем, либо в средствах автоматизации 
проектирования Synplify, LeonardoSpectrum
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Мастер New Project Wizard - запуск
1. Для создания проекта запустите 

мастера «New Project Wizard» - команда File>NewProjectWizard

3. Задайте имя проекта.  
    Имя может быть любым.   
    Однако рекомендуется 
    использовать имя,      
    соответствующее 
    имени  файла 
    верхнего уровня в иерархии 
    описаний проекта.

2. Укажите рабочую папку 
проекта

4. Задайте имя файла верхнего 
   уровня в иерархии описаний 
   проекта.



Copyright © 2003. Тренинг партнер фирмы Altera®   в России.  Санкт-Петербург,  СПбГПУ - ЭФО34

 К проекту можно добавить 
файлы следующих типов:
- Graphic (.BDF, .GDF)
- AHDL
- VHDL
- Verilog
- EDIF

• Файлы нижних уровней в иерархии 
описания  проекта, находящиеся в 
рабочей папке проекта, можно 
явным образом не добавлять к 
проекту. Они будут автоматически 
добавлены компилятором

Используйте эту кнопку для 
указания дополнительных 
библиотек

Мастер New Project Wizard – добавление 
файлов к проекту
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Укажите путь к 
библиотеке

Мастер New Project Wizard - задание 
дополнительных библиотек (User Libraries)

Укажите путь к библиотеке

Дополнительные библиотеки:

• Созданные Вами    библиотеки 

• Библиотеки модулей 
MegaCore®/AMPP SM  

• Откомпилированные  VHDL 
packages
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Мастер New Project Wizard - Подключение  дополнительных 
средств автоматизации проектирования (EDA Tool)

1. Выберите    подключаемое 
средство проектирования (EDA 
tools ) из списка.

2. Настройте используя кнопки 
Settings и Advanced.
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Мастер New Project Wizard - выбор семейства 
СБИС для реализации проекта

2. Укажите режим выбора типа 
СБИС:

• Автоматический выбор 
компилятором (NO)

• непосредственное назначение 
типа  СБИС (Yes)

1. Выберите 
семейство СБИС
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Мастер New Project Wizard - назначение  типа СБИС

Фильтры используются 
для упрощения поиска 
конкретной СБИС
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Мастер New Project Wizard - окно с результатами 
сделанных установок

Проверьте результаты 
сделанных установок и 
нажмите кнопку FINISH
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Project Configuration File

■ Автоматически генерируется 
мастером 
New Project Wizard 

■ Имя, задаваемое по 
умолчанию – 
<имя проекта.quartus>

■ Хранит конфигурацию 
проекта

■ Может редактироваться в 
текстовом редакторе
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Файл с установками проекта - *.PSF (Project 
Settings File)

■ Автоматически генерируется мастером 
New Project Wizard 

■ Имя, задаваемое по умолчанию - <имя проекта.psf>
■ Хранит установки проекта
■ Может редактироваться в текстовом редакторе
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Изменение установок проекта
■ Меню настроек «Assignments Menu» 

позволяет получить доступ ко всем 
настройкам и установкам проекта.

■ Для задания установок проекта 
следует открыть окно установок: 
меню Assignments ->  Settings

Меню
Assignments 
содержит набор 
мастеров, 
упрощающих 
задание 
некоторых 
установок.

Некоторые разделы окна Setting могут 
быть вызваны прямо из меню 
Assignments.
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Как открыть проект?

В меню File пакета Quartus II выберите Open Project

Двойным щелчком манипулятора по символу файла с расширением       
.quartus запустите пакет Quartus II. При этом будет автоматически 
загружен выбранный проект.

ИЛИ

ИЛИ

В меню File пакета Quartus II  в разделе Recent Projects выберите проект 
из списка тех проектов, которые открывали в последнее время.
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Архивация и восстановление проекта 
«Archive & Restore»

При выполнении команды 
меню: Project  >Archive Project 
создаются:

1. Файл - <имя проекта>.qar
-сжатый архивный файл с 
проектом

2.  Файл - <имя проекта>.qarlog
-файл с отчетом о 
результатах архивирования

При выполнении команды
Меню: Restore Archived Project 
восстанавливается архивированный 
проект
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Навигатор проекта 
«Project Navigator»
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■ Отображает иерархию 
проекта «Hierarchy View»

■ Навигатор может быть 
использован для 
выполнения установок 
для всего проекта и 
индивидуальных 
установок для каждого из 
модулей проекта 
– Для вызова меню 

настройки выберите 
модуль проекта и 
щелкните правой 
клавишей манипулятора

Закладка “Hierarchies” навигатора проекта
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Закладка «Files» навигатора проекта

■ Отображает папки
– Device Design Files (логические 

файлы проекта)
– Software Files (файлы с 

программами)
– Other Files (вспомогательные 

файлы проекта)
■ Имеет меню для работы с 

файлами (для вызова меню 
выберите файл и щелкните 
правой клавишей 
манипулятора)
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Закладка «Design Units» навигатора 
проекта 

■ Отображает все компоненты 
проекта

■ Использованный способ 
описания проекта и язык 
описания

■ Файл с описанием 
компонента 
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Компиляция проекта в пакете 
Quartus II
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Что такое объект компиляции «Focus 
Points»?

■ Компонент в иерархии описаний проекта, который 
будет компилироваться так, как если бы он был 
компонентом верхнего уровня в иерархии описаний.

■ Файл верхнего уровня в иерархии описания проекта 
(Top-level entity) является объектом компиляции по 
умолчанию.

Focus 
Point

Focus PointA

B C D

E

F
Focus 
Point
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■ Навигатор проекта 
– После выполнения команды 

Processing>Start> Start Analysis & 
Elaboration отображает иерархию проекта

– Может быть использован для установки 
объектов компиляции

Объект компиляции «Focus Points»

Этот знак показывает, что 
данный компонент выбран 
как объект компиляции

Выберите компонент
Нажмите правую клавишу манипулятора
Выберите команду Set Сompiler Focus to Current Entity
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■ Полная компиляция (Start Compilation)
– Полная компиляция, включая сборку 

СБИС
■ Start Analysis & Elaboration

– Проверка синтаксиса и построение базы 
данных объекта компиляции

■ Start Analysis & Synthesis
– Проверка синтаксиса, построение базы
 данных, синтез, оценка быстродействия 
объекта компиляции

■ Start Timing Analysis
– Только оценка быстродействия объекта 

компиляции
■ Start Design Assistant

– Запуск «помощника в проектировании»
■ Start SignalProbe

– Запуск компиляции в режиме SignalProbe
■ Stop – остановка процесса компиляции

Режимы компиляции

Доступ ко всем режимам 
компиляции через меню
Processing>Start

Иконы панели управления
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Окно состояния (Status) и 
окно сообщений (Message)

•Окно состояния отображает процесс выполнения этапов компиляции 
•Окно сообщений отображает :

• Информационные сообщения(синий символ)- informational,
• Предупреждения (желтый символ) -  warning 
• Сообщения о ошибках (красный символ) - error messages

Запустите полную компиляцию проекта, появятся:
Окно состояния компиляции; Окно сообщений.
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Отчет о компиляции (Compilation Report)

Окно отчета появляется автоматически 
после окончания компиляции. 
Оно содержит:

• сводную информацию (Summary)
• детальную информацию, разбитую на   
отдельные разделы.
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Редактор топологии (Floorplan)

■ Редактор топологии позволяет:
– Осуществлять текущие назначения (current assignments)
– Отображать результаты последней компиляции (Last 

compilation)
– Оптимизировать временные параметры  (timing closure)
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Установки компилятора
  «Compiler Settings»
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Редактирование установок 
компилятора  «Compiler Settings»

■ Прежде всего необходимо проверить синтаксис и построить базу 
данных для объекта компиляции (Processing>Start> Start Analysis 
& Elaboration )

■ Для редактирования установок компилятора используется:
– Мастер Compiler Settings (упрощает задание некоторых, базовых, 

установок)
– Окно Setting (вызывается меню Assignments> Settings> Compiler 

settings) позволяет задать все установки компилятора, включая
• Выбор, установка, задание параметров СБИС 
• Назначение выводов «Pin Assignments»
• Настройка системы логического синтеза «Synthesis Logic Options»
• Задание требований по быстродействию «Timing Requirements»
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Мастер - Compiler Settings(1)
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Мастер - Compiler Settings (2,3)

Задайте  объект компиляции 
(focus point) 
и имя установки для данного 
объекта компиляции 
(settings name)

•Скорость компиляции или сокращение 
используемого объема диска (Speed 
vs. disk space usage)?

•Сокращать число доступных для 
наблюдения узлов (Reduce node 
names)?
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Мастер - Compiler Settings (4,5)

Задайте  семейство СБИС 
(Family) 

Задайте  тип СБИС 
(Device) 
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Мастер - Compiler Settings (результаты 
установок)

Сохранить файл в формате VQM 

Окно с результатами установок.
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Окно Settings - редактирование 
установок компилятора

Для редактирования установок и настроек компилятора выберите
меню: Assignments > Settings >Compiler Settings



Copyright © 2003. Тренинг партнер фирмы Altera®   в России.  Санкт-Петербург,  СПбГПУ - ЭФО63

Окно Settings - выбор, установка, задание 
параметров СБИС

В окне Available devices задайте тип СБИС 

Выберите меню:Assignments > Settings >Compiler Settings>Device

 Параметры (Device and Pin Options):
•Общие «General»
•Конфигурации «Configuration»
•Файла программирования «Programming 
files»

•Неиспользованных выводов «Unused 
Pins»

•Выводов двойного назначения «Dual 
Purpose Pins»

•Напряжения питания «Voltage»
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Окно Settings - назначение выводов 
«Assign Pins»

Кнопка Assign Pin 
позволяет сделать 
следующие основные 
назначения:

• Номер и имя вывода
• Стандарт ввода/ вывода 
«I/O standards»

• Резервирование 
выводов «Reserve pins»
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Окно Settings - меню «Mode»
Позволяет выбрать режим компиляции 

•Скорость компиляции или сокращение 
используемого объема диска (Speed 
vs. disk space usage)?

•Сокращать число доступных для 
наблюдения узлов (Reduce node 
names)?
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Окно Settings - меню «Synthesis»

Меню Synthesis позволяет 
сохранить файл с результатами 
синтеза (* .vqm  )
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Окно Settings - меню «Fitting»

Меню Fitting позволяет:

•оптимизировать временные параметры
внутри СБИС «Optimize timing»

•оптимизировать временные параметры 
элементов ввода/вывода 
«Optimize I/O register placement
 for timing»

• варьировать параметром 
 «Seed»        

•Устанавливать режим оптимизации 
размещения внутренних ресурсов при 
размещении проекта
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Окно Settings - меню «SignalTapII»

Позволяет разрешить 
использование 
встроенного 
логического 
анализатора SiganTapII 
и задать файл с его 
настройками
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Окно Settings - меню «SignalTapII»

Позволяет разрешить 
использование 
помощника Design 
Assistant и задать его 
настройки
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Окно Settings - меню «Netlist 
оptimizations»

Позволяет задать 
режимы оптимизации 
списков соединений 
(Netlist) на:

• этапе синтеза 
(Synthesis) проекта

•сборки (Fitting) СБИС
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Повторный синтез примитивов   WYSIWYG 
(WYSIWYG Primitive Resynthesis)

■ Используется со списком 
соединений в формате 
Аtom, полученном во 
внешних системах 
автоматизации 
проектирования

■ Преобразует примитивы 
(логические элементы 
выбранного семейства 
СБИС) до уровня 
вентилей  и, затем, 
собирает их обратно в 
примитивы.

■ Опция недоступна при 
использовании синтеза, 
интегрированного в пакет 
QuartusII.
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Коррекция временных соотношений 
(Gate-level Register Retiming)

Опция, осуществляя изменения на вентильном уровне, 
позволяет:

■ Перемещать регистры сквозь комбинационные схемы 
с тем, чтобы выровнять временную диаграмму.

■ Выравнивать критические (Critical ) и некритические 
(Non-critical) цепи распространения сигналов. 
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■ Содержит установки компилятора
■ Имя файла <имя объекта компиляции>.csf
■ Может редактироваться в любом текстовом редакторе

Файл с установками компилятора - .CSF 
(Compiler Settings File)
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Редактор назначений
«Assignment Editor»
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Редактор Assignment Editor

Отображает имя файла, 
в котором хранятся 
настройки

Позволяет запрещать
отдельные назначения

Содержимое колонок 
можно сортироватьКонтекстно-зависимое меню

■ Заменил  Assignment Organizer
■ Поддерживает все семейства СБИС
■ Позволяет использовать Clipboard (CTRL-C, CTRL-V & CTRL-X)
■ Provides Spreadsheet Assignment Entry & Display
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Запуск редактора Assignments Editor

•  Выделите модуль в навигаторе проекта (закладка    
Hierarchies), 

•  нажмите правую клавишу манипулятора и в 
появившемся меню выберите Assigment Editor

Выполните команду 
Assignments =>Assigment Editor
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Запуск редактора Assignments Editor

■ Редактор 
назначений 
также можно 
запустить из:

–  окна 
результатов 
временного 
анализа 
(Timing 
Report), 

– окна 
сообщений 
(Messages)...

Выделите строку, нажмите правую 
клавишу манипулятора и в 
появившемся меню выберите 
Assigment Editor
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Assignment Editor (Закладка Category)

■ Позволяет 
выбрать 
категорию 
назначения

■ Закладка 
может быть 
свернута 
или скрыта
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Assignment Editor (закладка Node Filter)

■ Позволяет 
осуществлять 
фильтрацию 
отображаемых 
узлов

■ Позволяет 
отображать 
информацию о 
назначениях 
только для 
выбранных 
узлов
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Assignment Editor (закладка Information)

■ Отображает 
информацию 
о выбранной 
категории 
или ячейке

■ Закладка 
может быть 
свернута 
или скрыта
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Assignment Editor – настраиваемый набор столбцов

■ Каждая категория имеет собственный настраиваемый набор столбцов
■ Категория Pin включает общие временные назначения (Timing 

Assignments)
■ Для каждой категории предусмотрен столбец  для комментариев - 

‘Comment’
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Assignment Editor (динамическая проверка 
назначений)

■ Система динамической проверки назначений (Dynamic Checking of 
Assignments) обеспечивает:
– Проверку допустимости назначений в процессе их ввода
– Отображение цветом статуса назначения 

Серый – назначение
запрещено

Черный – назначение
активно

Желтый – предупреждение,
назначение нельзя
применить

красный – 
назначение
неполное

Зеленый – можно задать 
новое назначение 
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Assignment Editor (задание назначений)

Ввести назначение (контекстно-зависимое меню отображает применимые назначения)

Добавить новый узел 

Запустить систему поиска узлов (Node Finder)
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Система поиска узлов (Node Finder)
При поиске используйте 
групповые символы 
(wildcards)

Список узлов, найденных 
программой фильтрации в 
указанном модуле и 
в компонентах более низкого 
уровня иерархии.

Используйте программу 
фильтрации (Filter) для 
выбора отображаемых 
узлов

Выберите искомые узлы и 
с помощью стрелок 
перенесите их в правое 
окно (Selected Nodes)
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Настройка маски фильтрации 

Выберите клавишу 
настроить (Customize).
Появится окно 
настройки программы 
фильтрации.

Нажмите кнопку New.
Появится окно задания 
новой настройки
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Assignment Editor (создание TCL файлов)

■ При вводе назначения соответствующая  Tcl команда отображается в окне 
сообщений (закладка System). Команду можно скопировать для созданий 
управляющего TCL файла

■ Команда: меню File => Export Command автоматически создает Tcl 
файл с командами для всех назначений
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Assignment Editor (назначение выводов)
■ Позволяет 

отобразить все 
выводы проекта

■ Для каждого вывода 
можно задать банк  
и\или номер вывода 
микросхемы

■ Для каждого вывода 
можно задать 
стандарт 
ввода\вывода
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Assignment Editor (назначение выводов)

■ Позволяет 
отобразить все 
выводы СБИС и их 
свойства

■ Для каждого вывода 
можно задать 
стандарт 
ввода\вывода
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Assignment Editor (назначение выводов)

■ Для каждого вывода можно вывести столбцы с заданными временными 
параметрами

■ Позволяет включить\выключить отображение каждого банка ввода\вывода своим 
цветом
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Назначение выводов с использованием редактора 
разводки СБИС

■ Перетащите 
вывод из 
системы 
поиска узлов 
(Node Finder) 
в редактор 
разводки 
СБИС 
(Floorplan)
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Анализ назначений выводов

■ Позволяет быстро проверить допустимость сделанных назначений
– Не требует полной перекомпиляции проекта и даже не требует наличия всего 

проекта (для анализа достаточно Verilog Module Pin Declaration или VHDL 
Entity Statement или CSF File)

– Анализ проводится с помощью графического интерфейса или с помощью 
командной строки 

■ Проверку осуществляется в специальном режиме (Pin-Checker Mode) 
работы системы размещения ресурсов СБИС  (Fitter)
– Быстрое выполнение (~ 1 мин)
– Результаты отображаются в отчете о компиляции 
– В файле Pin Out указывается пользовательское назначение или назначение 

компилятора
– Проверяются все назначения (проверка не оканчивается при обнаружении 

ошибочного назначения)
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Запуск анализа назначений выводов
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■ Все заданные назначения хранятся в файле  <имя 
объекта>.esf

■ Файл будет автоматически создан пакетом Quartus II
■ В рабочей папке проекта может быть несколько 

файлов <имя объекта>.esf.

Файл для хранения назначений - .ESF 
(Entity Settings File)
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Анализ временных параметров  СБИС 
«Timing Analysis»
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Особенности 

■ В пакет Quartus II встроен статический временной анализатор
■ Временной анализ однотактной  синхронизации

– fmax (максимальная тактовая частота)
– Tsu время предустановки (setup time ) , 
– Th – время удержания (hold time), 
– Tco – задержка тактовая частота - выход (clock-to-out time)

■ Временной анализ многотактной (Multi-clock) синхронизации
– Позволяет проводить анализ при наличии нескольких 

синхросигналов, 
– Используется принцип анализа временных зазоров (Slack analysis)

■ Временной анализ осуществляется автоматически после 
компиляции.
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Раздел результатов временного анализа 

Папка с результатами временного анализа

Максимальная 
тактовая частота 
(fmax) для всех 
тактовых сигналов 
также отображается в 
окне сообщений
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Результаты временного анализа

■ Результаты временного анализа, 
находятся в папке с отчетом о 
компиляции

– Установки системы временного анализа

– Результаты временного анализа 
суммарно

 
– Таблица  результатов анализа для 

тактового сигнала

– Задержки передачи данных от входа до 
выхода СБИС - tpd (Pin to Pin Delays)

– Времена предустановки сигналов на 
входах СБИС -tsu (Input Setup Times)

– Времена удержания сигналов на входах 
СБИС - th (Input Hold Times)

– Задержки от тактового импульса до 
появления сигнала на выходе СБИС - tco 
(Clock to Out Delays)
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Анализ критического пути распространения сигнала 
(выбор пути для детального анализа)

Для детального анализа 
•Выберите критический путь
•Нажмите правую клавишу манипулятора
•В появившемся окне выберите List Paths
•В окне сообщений появится детальная информация о выбранном 
критическом пути
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Отображение критического пути в редакторе 
топологии СБИС

или

•В  окне укажите интересующий критический путь.
•Нажмите правую клавишу манипулятора
•В появившемся меню выберите 
  Locate in Last Compilation Floorplane

•В  окне процессора сообщений   
  выберите интересующий    
  критический путь.

•Нажмите правую клавишу 
манипулятора

•В появившемся меню выберите 
  Locate
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Отображение критического пути в редакторе 
топологии СБИС

Максимальная задержка 
распространения сигнала между 
регистрами в критическом пути
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Максимальная тактовая частота с учетом внешних 
задержек - System fmax  (Модели внешних задержек)

EC

ET A

C

tco tsu

Altera DeviceExternal Input Delay

Imaginary 
Register

E

Q ET

tco

External Output DelayAltera Device

EC

Imaginary 
Register

tsu

External Output Delay =  ET + tsu - EC

External Input Delay =  ET + tco + EC
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Управление объемом информации, отображаемым в результатах 
временного анализа (Timing Analysis Reporting).

Отображать 200 
критических путей

Отображать пути 
сигналов, имеющие 
tsu более чем 3 ns

Отображать 
критические пути с 
максимальной тактовой 
частотой меньшей  150 
MHz

Команда Assignments > Settings > Timing Settings > Timing Analysis Reporting
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Установка требований к временным 
параметрам (Timing Assignments)

■ Пакет позволяет задать требования для пяти параметров:
– Максимально допустимой частоте работы - fmax.
– Необходимому времени предустановки сигналов на входах СБИС 

относительно фронта тактового сигнала -  tsu.
– Требуемому времени удержания сигналов на входах СБИС 

относительно фронта тактового сигнала– thold.
– Задержки от фронта тактового сигнала на входе СБИС до появления 

данных на ее выходах – tco.
– Задержки распространения сигналов от входов до выходов СБИС -   

tpd.
■ Назначение требований может быть осуществлено глобально 

(для всей СБИС), либо индивидуально (для каждого конкретного 
вывода или группы выводов). Второй способ является более 
предпочтительным.
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Компиляция с доминированием установленных 
временных параметров (Timing Driven Compilation)

■ Данный режим компиляции, 
Timing Driven Compilation 
(TDC), понуждает компилятор 
так располагать логические 
элементы, чтобы 
удовлетворить заданным 
требованиям к временным 
параметрам СБИС.

■ Для установки режима 
выполните команду – 
Assignments>Settings>Compi
ler Settings>Fitting

■ Существует две настройки: 
– Optimize Timing – позволяет 

оптимизировать критические пути 
внутри СБИС.

– Optimize I/O cell register placement 
for timing – позволяет 
автоматически использовать 
триггеры в элементах ввода вывода 
СБИС. 

Отметим, что указанные настройки часто 
противоречат друг другу
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Глобальная установка требований к временным 
параметрам (задание максимальной тактовой частоты)

Для проекта, имеющего 
несколько тактовых сигналов, 
следует установить 
требования к максимальной 
частоте для каждого из них.

Глобальная установка 
требуемой максимальной 
тактовой частоты для 
проекта, имеющего один 
тактовый сигнал.

Выполните команду Assignments > Settings > Timing Settings>Clocks
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Максимальная тактовая частота с учетом внешних 
задержек - System fmax

      Для анализа тактовой 
частоты с учетом внешних 
задержек, следует:
– Выполнить команду 

Assignments > Settings > 
Timing Settings

– Установить опцию Include 
external Delay to and 
from pins in Fmax 
calculations

– Задать значение 
задержек
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Установка внешних задержек

Нажать кнопку 
Default External Delay

В появившемся окне задать 
значения задержек
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Индивидуальная установка требований к 
временным параметрам

■ Параметры tsu (setup time), th (hold time), tco 
(clock-to-out) могут устанавливаться индивидуально 
для каждого вывода СБИС.

■ Существует два режима задания этих параметров:
– Для всех цепей, связанных с входом (Single point)
– Точка-точка (Point-to-point)
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Пример:  назначение требований к параметру 
Setup

выберите раздел Timing

Выберите  tsu Requirement 
из контекстно-зависимого 
меню

Введите имя вывода для 
которого устанавливается 
требования к параметру 
tsu

Используйте 
источник цепи (From) 
для задания в 
назначения в режиме  
point-to-point 
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Режим - Multi-Clock Frequency Analysis
■ Позволяет анализировать временные параметры проекта, 

содержащего цепи передачи сигналов между регистрами, 
синхронизируемыми различными тактовыми сигналами.

■ По умолчанию в пакете Quartus II считается, что независимые 
тактовые сигналы имеют одинаковую частоту и одинаковый 
активный фронт.

clk1

tco tsu

Combinatorial 
logic

clk2

capturing edge

launching edge

clk1

clk2

data
Register 1 Register 2
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Резерв времени между двумя тактовыми 
частотами

■ Понятие «резерв времени» (Slack) используется для того, чтобы 
отслеживать задержку сигнала между регистром1 и регистром2

Положительный резерв времени (Positive Slack)
– Время поступления сигнала из регистра1 будет удовлетворять требуемому 

времени предустановки сигнала на входе регистара2 до прихода фронта 
синхросигнала на регистр2. 

Отрицательный резерв времени ( Negative Slack)
– Время поступления сигнала из регистра1 не будет удовлетворять 

требуемому времени предустановки сигнала на входе регистара2 до прихода 
фронта синхросигнала на регистр2.

clk1

tco tsu

Combinatorial 
logic

clk2

data
Register 1 Register 2
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Задание тактовых сигналов 
Меню Assignments > Settings > Timing Settings>Clocks

Отметьте опцию 
управляющую 
заданием тактовых 
сигналов

Для задания новых 
установок нажмите 
кнопку New
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Задание базового тактового сигнала 
(Base Clocks)

Задайте имя 
установки

Для базового 
тактового сигнала 
выберите данную 
опцию

Установите 
требуемую fmax и 
скважность (Duty 
Cycle)

Нажмите кнопку OK
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Задание вторичного тактового сигнала 
(Derived Clocks)

Задайте имя создаваемой установки для 
вторичного тактового сигнала

Для вторичного тактового сигнала 
выберите данную опцию и укажите имя 
установки базового сигнала

Нажмите на кнопку 
Derived Clock 
Requirements

Нажмите кнопку New
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Задание требований к параметрам вторичного 
тактового сигнала (Derived Clocks)

Установите соотношение тактовых частот базового и вторичного тактовых сигналов и сдвиг фаз между ними. 
Вторичный тактовый сигнал может быть инвертированным базовым сигналом.  

Нажмите кнопку OK.
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Многотактовая синхронизация

■ Сигнал, время распространения которого от регистра к регистру 
превышает длительность одного такта тактового сигнала – 
сигнал с многотактовой синхронизацией

■ Объявление сигнала с многотактовой синхронизацией позволяет 
системе анализа временных параметров (Timing Analyzer)  
анализировать время прихода этого сигнала в течений 
нескольких периодов тактового сигнала

launching edge

base clock

derived clock

capturing edge
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Установка многотактовой синхронизации 
(Multi-Cycle Assignment)

1)  Выберите категорию 
Timing

Assignments > Assignment Editor...

4)  Задайте число тактов

2)  Укажите имя тактового 
сигнала (нажмите правую 
клавишу манипулятора, 
выберите edit cell и запустите  
node finder) 

3)  Выберите  Multicycle из 
контекстно-зависимого меню
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Система 
LogicLock
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■ Система LogicLock упрощает блочно-иерархический подход к 
проектированию, обеспечивая возможность разработки и оптимизации 
каждого блока в отдельности с привязкой его к выделенной зоне 
физических ресурсов СБИС.

■ Система LogicLock позволяет реализовать:
– Модульную процедуру проектирования (Modular Design Flow)
– Командно-ориентированную процедуру проектирования (Team-Based Design 

flow)
– Процедуру проектирования последовательного наращивания функций 

(Incremental Design Flow)

■ Зона LogicLock – набор параметров, определяющий прямоугольную зону 
физических ресурсов на СБИС. 

■ Привязка  модулей (entities), узлов (nodes) или критических путей 
распространения сигналов (paths) к зоне LogicLock вынуждает 
компилятор размещать указанные логические ресурсы компактно в 
выделенной зоне физических ресурсов СБИС.

Система  LogicLock (общие понятия)
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■ Цели использования:
– На этапе оптимизации отдельного модуля

• Достижение максимальной производительности. Что обеспечивается 
компактным размещением логических ресурсов в выделенной зоне 
физических ресурсов СБИС

– На этапе интеграции модулей в проект верхнего уровня иерархии
• Сохранение достигнутого уровня быстродействия модуля. Что 

обеспечивается возможностью фиксации как размещения логических 
ресурсов в выделенной зоне физических ресурсов, так и результатов 
трассировки соединений. И возможностью их экспорта в проект верхнего 
уровня иерархии описаний

– При реализации процедуры проектирования с последовательным 
наращиванием функций

• Минимизация времени перекомпиляции всего проекта и сохранения 
достигнутого уровня быстродействия как исходного проекта, так и 
добавляемого модуля. Что достигается путем фиксации размещения 
логических ресурсов и результатов трассировки соединений исходного 
проекта и возможностью экспорта результатов размещения логических 
ресурсов и результатов трассировки добавляемого модуля в исходный 
проект.

Цели использования системы LogicLock
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■ Размещение связанных логических ресурсов в непосредственной 
близости друг от друга (в рамках заданной зоны) позволяет добиваться 
максимального быстродействия (максимальной тактовой частоты 
работы) модуля

Оптимизация быстродействия модуля
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■ Поддерживаемые семейства СБИС
– Stratix
– Stratix GX
– Cyclone
– APEX II
– All APEX 20K
– Excalibur

■ Поддерживаемые средства проектирования
– Любые средства проектирования, обеспечивающие формирование 

списка соединений в формате .edf или .vqm с использованием ATOM 
примитивов

• Synplify
• LeonardoSpectrum
• FPGA Express

Поддержка семейств СБИС и систем 
проектирования
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Окно зон LogicLock (LogicLock Regions Window)

Открыть окно свойств зоны 
(LogicLock Region Properties)

Создать новую зону

Вызов окна LogicLock Region Window :
Assignments=>LogicLock Region Window

или
Иконка          на панели инструментов  

Созданные зоны

Параметры созданных зон



Copyright © 2003. Тренинг партнер фирмы Altera®   в России.  Санкт-Петербург,  СПбГПУ - ЭФО124

Окно LogicLock Region Properties 
(закладка Contents)

Узлы и модули, связанные с зоной

Нажмите на кнопку для фиксации (Lock) 
результатов размещения логических ресурсов 

Резервирование неиспользованных 
физических ресурсов зоны

Окно задания критических 
путей распространения 
сигналов для связи их с зоной 
LogicLock
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Окно LogicLock Region Properties 
(закладка Size )

Задание типа размера:
• Auto – размер, определяемый компилятором
• Fixed -  размер, задаваемый пользователем

Задание размера:
• Width – ширина (колонок)
• Height -  высота (строк)

Физические ресурсы зоны
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Окно LogicLock Region Properties 
(закладка Location )

Кнопка фиксации положения зоны, 
использованного при последней компиляции

Задание положения зоны: 
• Locked – фиксированное положение
• Floating – плавающая зона

Задание точки привязки зоны к 
физическим ресурсам СБИС

Задание зоне признака Soft
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Создание зон LogicLock и связывание их с 
логическими ресурсами
■ Способы создания зон LogicLock

– Использование строки <new> в окне LogicLock 
Regions

– Использование иконки         в редакторе 
размещения внутренних ресурсов СБИС (Timing 
Closure Floorplane)

■ Способы связывания логических ресурсов с 
зоной LogicLock

– Перетащить модуль из окна отображения иерархии 
проекта в окно LogicLock Regions 

– Перетащить модуль из окна отображения иерархии 
проекта в редактор размещения внутренних 
ресурсов СБИС (Timing Closure Floorplane) 

■ Создание зоны и одновременное связывание с 
логическими ресурсами проекта

– В окне иерархического отображения проекта 
выделить логический ресурс (модуль), нажать 
правую клавишу манипулятора, и в появившемся 
контекстно-зависимом меню выбрать команду 
Create New LogicLock region



Copyright © 2003. Тренинг партнер фирмы Altera®   в России.  Санкт-Петербург,  СПбГПУ - ЭФО128

Типы зон LogicLock

Locked 
Fixed

Floating 
Fixed

Floating 
Auto

Создать зону

Отображение пользовательских назначений
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Иерархия зон (Parent and Children Regions

Parent

Child Grandchild

Parent

Child

■ Зоны Child должны размещаться 
внутри зоны Parent

■ зоны Child могут быть Float (Locked)  
и Auto (Fixed) относительно зоны 
Parent (в зависимости от ее типа).

■ Допускается многоуровневая 
иерархия зон (т.е. grandchildren)
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Блочно-иерархическое проектирование

top

statem:inst1

filtref:inst2

filtref

filtref:inst1

statem
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Этапы процедуры проектирования
■ Реализовать декомпозицию проекта – выделить набор модулей проекта
■ Проектирование модулей нижнего уровня иерархии

– Проектирование и оптимизация модуля filtref 
• Создать проект для модуля filtref
• Отладить модуль
• Оптимизировать аппаратные затраты
• Оптимизировать быстродействие с использованием зоны logicLock
• Зафиксировать результаты размещения логических ресурсов
• Экспортировать результаты размещения логических ресурсов 

(файлы filtref.esf  и filtref.vqm)
– Проектирование и оптимизация модуля statem (аналогично модулю 

filtref )
■ Проектирование модуля верхнего уровня в иерархии проекта

– Создать проект top
– Скопировать  файлы filtref.esf, filtref.vqm, statem .esf, statem .vqm в 

рабочую папку проекта Top.
– Импортировать модули filtref и statem в проект top.
– Осуществить компиляцию проекта Top
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Фиксация  результатов размещения логических 
ресурсов (Back-Annotating Contents)

■ Фиксация результатов размещения логических ресурсов позволяет (но в 
общем случае не гарантирует) сохранить достигнутый уровень 
быстродействия модуля при его интеграции в модуль более высокого 
уровня в иерархии описаний проекта.

■ Положение модуля, для которого осуществлена фиксация результатов 
размещения логических ресурсов, может оставаться плавающим.
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Экспорт зоны logicLock и результатов 
размещения логических ресурсов

■ Позволяет передать информацию о зоне logicLock и о зафиксированных 
результатах размещения логических ресурсов модуля в другой проект

■ Создается файл  .esf 
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Импорт  зоны logicLock и результатов 
размещения логических ресурсов
■ Позволяет получить информацию о зоне logicLock и о зафиксированных 

результатах размещения логических ресурсов  для модуля нижнего уровня 
иерархии

■ Читается файл .esf 
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Результат импортирования модулей 

■ Все импортированные зоны имеют плавающее положение (floating 
origin). После импортирования положение может быть зафиксировано 
(lock)

■ Взаимное расположение логических ресурсов внутри модулей 
сохранено, что позволяет (но не гарантирует) сохранить достигнутый 
ранее уровень быстродействия отдельных модулей.

filtref:inst1 filtref:inst2

top

statem:inst1
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Отображение в редакторе размещения внутренних 
ресурсов (Timing Closure Floorplan)

■ Редактор размещения внутренних ресурсов позволяет отображать как 
текущие назначения, так и результат последней компиляции

результат последней компиляции текущие назначения



Copyright © 2003. Тренинг партнер фирмы Altera®   в России.  Санкт-Петербург,  СПбГПУ - ЭФО137

Моделирование в пакете 
Quartus II
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Возможные методы моделирования

■ Ввод временных диаграмм в пакете QuartusII (Waveform entry )
– .vwf (vector waveform file) – файл редактора временных диаграмм 

пакета Quartus II
– .vec (vector file) – векторный файл, использовавшийся в пакете 

MAX+PLUS II, поддерживается для обратной совместимости пакетов
– .tbl (table file) – табуляционный файл, используемый для 

импортирования временных диаграмм, созданных в пакете 
MAX+PLUS II (.scf), в пакет Quartus II

■ Создание тестовых воздействий на языеTcl/TK 
■ Использование систем моделирования сторонних 

производителей (Modelsim, ActivHDL…) 
– Создание тестов на языках Verilog/VHDL
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■ Система моделирования пакета QuartusII поддерживает  9 
уровней сигнала

– 1 Forcing ‘1’

– 0 Forcing ‘0’
– X Forcing unknown
– U Uninitialized
– Z High impedance
– H Weak ‘1’
– L Weak ‘0’
– W Weak unknown
– DC Don’t Care

Поддерживаемые уровни сигналов 
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Задание параметров моделирования 
(Simulator Settings)
■ Параметры позволяют задать тип и режимы моделирования
■ Quartus II позволяет сохранять набор заданных параметров (настройку) 

моделирования

Для задания параметров моделирования может быть использован мастер Simulator Setting Wizard
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Задание параметров моделирования 
(выбор объекта моделирования)

Система моделирования позволяет выбирать объекты моделирования (Simulation 
Focus) среди созданных объектов компиляции (Focus Points)
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Задание параметров моделирования 
(настроек - Time/Vectors)

Время моделирования

Время моделирования 
ограничивается длиной 
файла с тестовым 
воздействием

Отображает результат 
сравнения теста и 
результаты 
моделирования

Задание файла с 
тестовыми 
воздействиями

Меню Assignment>setting>Simulator Settings>Time/Vector
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Задание параметров моделирования 
(режим моделирования - Mode)

■ Определены два режима 
моделирования
– Функциональное
– Временное 

Меню Assignment>setting>Simulator Settings>Mode
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Задание параметров моделирования 
(дополнительные параметры моделирования - Options)

Указывать процент 
покрытия тестом  всех 
возможных изменений 
сигналов проекта

Добавить в окно сообщений 
отчет о нарушениях  
времени предустановки и 
удержания сигнала на входе 
триггера (setup,hold)

Проводить анализ сбоев 
(glitches) и отображать его 
результаты в окне сообщений

Временной интервал, 
определяющий сбой 
(Glitch)

Меню Assignment>setting>Simulator Settings>Options
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Создание файла с временными 
диаграммами  (.VWF)
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Создание файла временных диаграмм

■ Создание файла:
– File=>new
– В окне New:

• Закладка Others
• Тип файла – Vector 

Wavewform File
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Ввод узлов  (Nodes)
■ Команда Edit=> Insert Node or Bus

Выберите узлы с помощью системы
Node Finder
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Задание длительности моделирования
■ Выполните команду Edit=>End Time
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Ввод временных меток (Time Bars)

■ Только одна временная метка (time bar) 
может быть основной (master)

■ Временные метки (Time bars) могут иметь 
абсолютную временную привязку (absolute) 
или относительную – относительно основной 
временной метки (relative to master). 

Временная метка 
(Time Bar)

Задание временной 
метки (time bar)

Задание основной 
временной метки (master 
time bar)
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Ввод временной диаграммы входного 
сигнала (Stimulus Waveform)

■ Выделите участок временной диаграммы, который 
необходимо изменить

■ Замените значение (я) на выделенном участке требуемым 
значением. 

Выберите новое 
значение

Соответствующие 
иконки на панели 

инструментов

Выделенный участок 
временной 
диаграммы
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Запуск моделирования

▪ Для запуска системы 
моделирования могут 
использоваться 
следующие команды:
▪ Processing =>Start 

Compilation & Simulation 
▪ Processing => Start 

Simulation
▪ Иконка       на панели 

инструментов
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Отчет о результатах моделирования 
(Simulator Report)

Обобщенные результатыОтчет о результатах 
моделирования
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Отчет о результатах моделирования 
(отображение временной диаграммы)

Выберите Simulation Waveform для 
отображения временных диаграмм с 
результатом моделирования

Откройте отчет о 
результатах 
моделирования

Результаты моделирования



Copyright © 2003. Тренинг партнер фирмы Altera®   в России.  Санкт-Петербург,  СПбГПУ - ЭФО154

Сохранение временной диаграммы с 
результатами моделирования

■ Выполните команду 
File=>save As

■ Введите имя файла
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Сравнение временных диаграмм
■ Откройте файл в редакторе временных 

диаграмм (или временную диаграмму с 
результатами моделирования),

■ выполните команду View => Compare to 
Waveforms, 

■ укажите файл временных диаграмм с 
которым будет осуществляться 
сравнение
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Результат сравнения временных диаграмм

■ Временные диаграммы совпадают

■ Временные диаграммы отличаются

■ Можно отобразить 
– исходную временную 

диаграмму
– Временную диаграмму с 

которой осуществляется 
сравнение

– Обе одновременно 

■ В окне сообщений 
отображаются результаты 
сравнения 

■ Команда окончания сравнения 



Copyright © 2003. Тренинг партнер фирмы Altera®   в России.  Санкт-Петербург,  СПбГПУ - ЭФО157

Результат сравнения временных диаграмм

■ ORIGINAL     (CTRL+1)

■ ACTUAL       (CTRL+2)

■ COMPARED (CTRL+3) 
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Система оценки потребления энергии - 
PowerGaugeTM

■ Оценивает потребление энергии базируясь на частоте и 
количестве переключений, задаваемых тестом введенным 
пользователем в редакторе временных диаграмм 

■ Поддерживаются семейства СБИС: STRATIX, APEX 20KE, 
Excalibur, & Mercury

■ Пакет ModelSim позволяет получить файл .pwf, который может 
быть прочитан пакетом Quartus II для оценки быстродействия

Project >EDA tool settings 
>ModelSim settings 

Generate Power Input File
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Получение оценки потребления энергии

1.  Задайте опцию Power Analysis

2. Осуществите моделирование и 
выберите раздел “Summary” в 
отчете о моделировании

3. Результаты: Internal, I/O, Total …
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 Использование систем моделирования 
сторонних производителей

■ Системы моделирования
– Model Technology (ModelSim)
– Cadence (VERILOG-XL & NC-Verilog)
– Synopsys (VCS)
– Synopsys (VSS)

■ Режимы моделирования
– Функциональное моделирования (Functional Simulation)

• 220models и altera_mf
– Временное моделирование 

• VHDL
– Quartus II формирует  .VHO и .SDO файлы
– Используйте библиотеки примитивов STRATIX_ATOMS.VHD, 

STRATIX_ATOMS_COMPONENTS.VHD… расположенных в папке sim_lib
• Verilog

– Quartus II формирует .VO и .SDO файлы
– Используйте библиотеки STRATIX_ATOMS.VO… расположенные в папке 

sim_lib 
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Выбор системы моделирования
■ Выполните команду Assignments => Settings…=>EDA Tools Settings
■ Укажите и настройте используемую систему моделирования



Copyright © 2003. Тренинг партнер фирмы Altera®   в России.  Санкт-Петербург,  СПбГПУ - ЭФО162

Преобразование временной диаграммы в 
тест на языке HDL

■ Пользователь может преобразовать файл 
редактора временных диаграмм в тест на 
языке VHDL или VerilogHDL
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Преобразование проектов из пакета 
MAX+PLUS II в пакет Quartus II



Copyright © 2003. Тренинг партнер фирмы Altera®   в России.  Санкт-Петербург,  СПбГПУ - ЭФО164

Встроенный
логический
анализатор 
SignalTap™
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Содержание

■ Проблемы использования традиционных средств 
отладки

■ Структура логического анализатора SignalTap
■ Предоставляемые SignalTap возможности
■ Использование в SignalTap среде Quartus II
■ Поддерживаемые устройства
■ Затраты ресурсов СБИС
■ Необходимое оборудование
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Проблемы использования традиционных 
средств отладки

■ Традиционные средства отладки плат
– Использование пробников или логических анализаторов

■ Проблемы отладки систем высокой интеграции
– Нет доступа ко внутренним ресурсам ИС
– Сложно подключить внутренний сигнал к выводу ИС

• Необходимо изменять содержание и иерархию проекта
• Необходимо резервировать выводы микросхем

■ Проблемы, порождаемые новыми корпусами
– К выводам корпусов TQFP доступ затруднен
– К выводам корпусов BGA доступ невозможен
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Встроенный логический анализатор 
SignalTap

JTAG

Quartus

MasterBlaster
Communication

Cable

ByteBlasterMV
Download Cable

Serial

USB
OR

Parallel
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SignalTap II Flow

Capture Samples and 
Analyze

Program
Device under

Test

Program
Device under

Test

View Samples in
Quartus 
IISoftware

View Samples in
Quartus 
IISoftware

Identify Source
Of 
Problem!

Identify Source
Of 
Problem!

Your HDL
Design

Your HDL
Design

Synthesis,
Place and

Route

Synthesis,
Place and

Route

Program
Device under

Test

Program
Device under

Test

Set up Your Design

Set up SignalTap II Embedded Logic Analyzer

Use Node Finder
To Select
Signals

Use Node Finder
To Select
Signals

Set up Signals,
Trigger Conditions
& Trigger Levels

Set up Signals,
Trigger Conditions
& Trigger Levels

Synthesis,
Place and

Route

Synthesis,
Place and

Route
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Структура SignalTap

Embedded
Logic

Analyzer

Memory

Clock

Входные
сигналы

Неиспользуемые
выводы

Trigger
In and Out

JTAG порт

Общая структура Кольцевой
буфер

захвата
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Trigger Input & Output

■Trigger by an External Source

■Supply an External Signal to Trigger External Test 
Equipment

ELA
Memory JTAG Port To JTAG

Connector

Signals From
Internal Nodes

Signals To
Debug PortsELA

Core 
Logic

Trigger OutputTrigger Input

To Unused
I/O Pins
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Возможности SignalTap

■ Синхронный логический анализатор 
■ Доступ ко всем выводам и внутренним узлам

– на работающей системе, в реальном времени
– не требуется модификации проекта
– одновременное наблюдение множества сигналов
– сохранение результатов в файле

■ Настраиваемые параметры анализатора
– до 1024 сигналов
– до 128 кбит отсчетов
– выбор источника синхронизации (10 признаков)
– запуск по внутреннему или внешнему событию
– Частота до 200 МГц.
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Условия старта захвата данных

■ Все анализируемые сигналы могут участвовать в 
формировании условия
– Различные условия объединяются по “И”

■ Условием старта может быть логический уровень или перепад
■ Возможно использование внешнего сигнала старта (Trigger In)
■ Событие старта захвата может быть выдано на один из 

выводов ИС (Trigger Out)
■ Возможно получение предыстории процесса
■ Условия можно менять без перекомпиляции проекта
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Использование SignalTap в среде Quartus II

■ Создать файл конфигурации SignalTap
– New 🡪 Other Files 🡪 SignalTap File

■ Выбрать сигналы для наблюдения
■ Указать синхросигнал
■ Задать размер буфера
■ Настроить условия запуска (триггеры)
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Ресурсы, затрачиваемые SignalTap

■ SignalTap использует следующие ресурсы СБИС
– логические элементы

• мегафункция анализатора, автоматически вставляется в 
проект средствами Quartus 

– память
• для хранения отсчетов сигналов

– выводы СБИС
• неявно резервируются неиспользованные выводы для 
обмена с компьютером

■ Три различных конфигурации
– Использование внутренней RAM
– Использование отладочного порта (Port ELA)
– Использование внутренней RAM и отладочного порта 
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Stratix LE Usage

Number of 
Channels

8

16

32

64

256

1024

Logic Elements 
Trigger Level 1 Trigger Level 2 Trigger Level 3

219

243

422

689

2295

8696

266

373

596

1033

3662

14158

317

466

773

1383

5034

19626
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Stratix M4K Usage

Number of 
Channels

8

16

32

64

256

512

Number of Samples

<1

1

2

4

16

32

4

16

32

128

256

64

128

256

512

256 512 2K 8K 32K

   1  16

2

4

8

64

32

8 32

64

128

512

Too large Too large

Too large
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Необходимое оборудование для работы с 
SignalTap

Supply 
Voltage

SignalTap 
Device 
Support

Comm.
Port

Board 
Connection

1.8 V, 2.5 V

3.3 V, 5.0 V

APEX 20K
APEX II
(1.8-, 2.5-, 3.3-V)
Startix   Mercury

RS-232

USB

Parallel

MasterBlaster ByteBlasterMV

(External Supply)

(NT, Solaris, HP-UX)
(Win 98/2000, NT 5.0)

JTAG (10-Pin)

(3.3-V Only)

JTAG (10-Pin)
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SignalTap и SignalProbe

■ SignalTap - встроенный логический анализатор, 
построенный на свободных ресурсах ИС

■ SignalProbe - средство подключения внутренних 
сигналов к выводам ИС для наблюдения внешним 
анализатором
– не требует модификации проекта
– не затрачивает логических ресурсов ИС
– затрачивает выводы ИС
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Заключение

■ SignalTap - новая технология отладки систем в 
реальном времени;

■ SignalTap обеспечивает нaблюдаемость внутренних 
узлов устройства;

■ Полученные данные сохраняются в файле временных 
диаграмм;

■ MasterBlaster применяется как для работы с SignalTap 
так и для конфигурации устройств:
– Высокая скорость обмена;
– Multi-Voltage (5.0 V, 3.3 V, 2.5 V и т.д.).


